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Bentley Software  

There are many individual software packages included in the Bentley family of 

softwares.  These include Open Roads Designer (ORD), Open Bridge Designer (OBD), 

Open Bridge Modeler (OBM), MicroStation and other specialty specific softwares such 

as ProStructures, OpenRail & OpenTunnel.  MicroStation is a computer aided drafting 

(CAD) package that can do all basic detailing oriented work including both two 

dimensional (2D) linework and three dimensional (3D) solids and visualization.  Open 

Roads Designer builds special roadway oriented abilities on top of the basic 

MicroStation capabilities such as corridor work, roadway design, etc.  The Open Bridge 

Modeler CADD package adds 3D structural modeling capabilities to the basic 

MicroStation capabilities.  It provides intelligence and is currently tied to the design 

packages associated with Open Bridge Designer.  Open Bridge Modeler may be a 

standalone product in the future.  ProStructures can model structural steel and 

reinforced concrete structures.  Since most of the packages are based on the basic 

MicroStation capabilities, any of them may be utilized to do CAD drawing and plan 

production.  Each software has its own cost implications for licensing.  The current 

configuration is set up to support ORD & OBD/OBM.  3D modeling has benefits for 

visualization, interference checks and communication but is not necessary for all 

projects.  3D modeling and deliverables will be evaluated on a project by project basis.  

The majority of the information contained in this appendix is based on basic 

MicroStation capabilities and can be used in most of the Bentley packages. 

 

B.1 Configuration 

Training materials, manuals, workflows, video tutorials and other resources can be 

accessed online at:  

https://www.codot.gov/business/designsupport/cadd/ 

The training videos cover assorted subjects.  There are also a number of CDOT 

workflows in pdf format for the Bentley software user that address specific drafting 

issues. 

The Bridge Detailer should become familiar with all the available information posted 

online at the above mentioned web locations.  In addition, this information is available 

through the Help and CDOT Help links available on the menu bar. 

https://www.codot.gov/business/designsupport/cadd/
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Fig. B.1-1 Help and CDOT Help in ORD 10.xx 

In addition to the CDOT Help, the search ribbon allows the user to find commands. 

 

 

Fig. B.1-2 Search Ribbon and Bentley Help in the Top Right  
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In the Bridge Workflow (top left), several ribbon tabs have been provided to make 

production easier.  The Home tab contains some miscellaneous tools including a steel 

shape generator as well as cell selectors for the available cell libraries. 

 

 

  

The Favorites Tab is intended to provide most commonly used drafting commands and 

tools. 
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B.2 Seed Files 

When working in ORD and OBM, the Bridge Detailer has the option of opening an 

existing drawing or starting a new one based on the existing bridge templates.  Drawing 

templates are called “seed files” and are included in the configuration files.   

Three seed files are available for the preparation of bridge drawings. They are named 

Bridge-2D-Seed_CDOT.dgn , Bridge-3D-Seed_CDOT.dgn and Bridge-ModelSeed-

CDOT.dgn.  

 

 

Fig. B.2-1 Bridge Seed Files in ORD 10.10 (as an example) 

Fig. B.2-2 Bridge Seed File in OBD 10.12 

These seed files are located at C:\ProgramData\Bentley\OpenRoads Designer CE 

10.xx\Configuration\Organization-Civil\CDOT_Bridge Standards\OpenBridge Modeler.  

There is also a seed file for the Sheet or Border called Bridge-2D-

Seed_CDOT_Sheet.dgn located at C:\ProgramData\Bentley\OpenRoads Designer CE 

10.xx\Configuration\Organization-Civil\CDOT_Bridge Standards\OpenBridge 

Modeler\Seed\Sheets. 

The Bridge 2D seed file contains one 2D model named CDOT Default where the 

detailer will create all line work for details at full scale (1:1). This model cannot be 

deleted. It is preferred to use this seed file when 3D information is not available or not 

needed.  In order to avoid display depth, global origin and other 3D issues, it is 
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recommended that the 2D seed file be used for all drawings that do not require 3D 

presentation. 

The Bridge 3D seed file contains one 3D model named CDOT Default where the 

detailer will create all line work for details at full scale (1:1). This model cannot be 

deleted.  

It is also recommended that a 2D model be used for the Sheet.  

The Sheet model will contain the information from the CDOT Default model referenced 

at the appropriate scale to be displayed in a readable manner on the plan sheet. 

There are 3 model types available in ORD: design models, drawing models, and sheet 

models (see ORD Help for definition).  By default, in the bridge seed files the CDOT 

Default model is a design model.  The Sheet model is set up so the detailer can switch 

to sheet type if so preferred.  One of the benefits of sheet models is they can be 

selected specifically by the Print Organizer utility.   

You can open the Model Properties dialog box by selecting Models icon in the Primary 

tab of the Home ribbon in the Bridge workflow.(see Fig. B.2-1) 

 

 

 

Fig. B.2-1 Models Icon and Models  in the Bridge Model Seed File 
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B.3 Borders 

There are two cells for bridge borders: Plan & Plan-Profile.  Most of the time we’ll just 

use the Plan border.  Sheet borders can be automatically generated by using some of 

the drawing generation tools 

The CDOT border is typically plotted on 11” x 17” paper at scale 1”=1” and it is a cell 

named Bridge - Plan located in Sheets – Bridge.cel library file.   

 

 

Fig. B.3-1 Border Selection  

The middle part of the border requires the insertion of a cell for the Resident 

Engineer/Bridge Unit information but this may be automatically generated using workset 

printing options in the future.   

B.4 Reference Files 

A Reference is a model that is attached to and displayed with the active model for 

printing or construction purposes.  You can reference/attach a model from a different 

dgn file or a model from the same dgn file (like attaching Linework model into the Border 

Model of the same dgn file).  For that, go to File > References and then select Tools > 

Attach… and browse for the dgn file that you want to reference. 

In order for the objects in a reference to be printed with the appropriate line weights, 

make sure to check the Line Weights box in the Reference Presentation dialog box 
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(References > Settings > Presentation).  Check the Use View Flags box, click on Line 

Weights, then de-select the View Flags check box and select OK. 

 

Fig. B.4-1 Reference Presentation Dialog Box 

Container files can be created on projects where all needed references are added to 

one empty dgn so you can reference one file which references the multiple specialty 

groups instead of referencing multiple files.  This is done through nesting.  Nesting 

should be kept to a minimum since multiple levels of nesting can reference the same file 

twice. 
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B.5 Levels 

Levels in MicroStation are defined in the CDOT configuration by Color, Style, and 

Weight. Currently, there are 13 general bridge levels (see table below) and over 150 

specific bridge levels defined in the CDOT configuration.  

The specific bridge levels mimic the general bridge levels, that is, most “Outline” levels 

print the same as the general Outline level, having the same line style and line weight, 

but a different color.  The purpose of the additional levels is to help in turning the levels 

off/on in different views and provide additional information for the detailer when 

developing linework.  Additional levels are available in Open Bridge Modeler to support 

three dimensional modeling. 

The following table indicates the MicroStation general levels to be used to comply with 

the requirements described in Chapter 2 of the Bridge Detail Manual:  

Level Name 
Color Line Style Line Weight 

How it prints in 

ORD/OBM 

BRDG_BREAK 7 0 0 

 

BRDG_CENTER 7 4 0 

BRDG_CONSTRUCT 4 0 1 

BRDG_CONTROL 3 0 3 

BRDG_DASHED 2 3 1 

BRDG_DIMENSION 2 0 1 

BRDG_FROZEN 2 0 0 

BRDG_HIDDEN 5 5 1 

BRDG_OUTLINE 3 0 2 

BRDG_PATTERN 6 0 1 

BRDG_REBAR 1 0* 3 

BRDG_TEXT 4 0 1 

BRDG_TITLE 1 0 3 
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* BRDG_Rebar linestyle can be applied to elements on level as desired.  Dash length is 

dependent on linestyle scale. 

The addition or modification of bridge levels requires concurrence within the Bridge 

Users Group (BUG) committee at CDOT.  The detailer is advised to use the levels 

defined in the configuration but can manipulate element symbology to achieve the 

desired drafting requirement, e.g. changing to the Rebar linestyle. 

There are various ways to view and select an active level, as follows:    

• Select the level from the Attributes tool box, as shown in Fig. B.5-1.  

 

Fig. B.5-1 Active Level Selection  

 

• Double click on a level in the level display window. (Fig. B.5-3) 
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Fig. B.5-3 - Bridge Level Selection from the Level Display 

Level filters are a useful way to group associated levels for the purposes of viewing or 

removing unneeded levels from view.  Filters can be used in both the Attributes tool box 

and the Level Display window.  There are several predefined filters available that cannot 

be modified by the user. (see Fig. B.5-4)   

“On the fly” filters can be created in the Level Display window.  To do that, first click on 

the Level Display icon on the Primary Tools tool box, then click the List Filter icon and 

select Untitled, then enter the desired filter criteria in the appropriate categories (Name, 

Color, Line Style etc.) in the top row.  The example in Fig. B.5-5 shows a filter created 

“on the fly” with “brdg” in the name, a line style value of “0” and a line weight value of 

“3”.  This filter can be toggled on/off by clicking the List Filter icon and selecting None.  

The filter remains until you exit MicroStation.   
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Fig. B.5-4 – Some of the CDOT Predefined filters 

 

 

Fig. B.5-5 – Example of filters “on the fly” 
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All the configuration levels have an assigned color associated with the level.  Although 

the color number of the level can’t be changed, its appearance to individual user can.  

The user can personalize the color table without affecting the plot styles:  Settings > 

Color Table…> Select the color you want to change, click on Change, pick the color you 

want to replace with and click OK, then select Attach. 

 

 

Fig. B.5-6 - Personalizing the Color Table 

Many levels have been provided for the depiction of reinforcing, several of which are 

shown in Fig. B.5-7.   Except for BRDG_Rebar-1 through BRDG_Rebar-4, most of the 

reinforcing levels are configured to show as a heavy weight continuous line as 

described in Chapter 2.  The BRDG_Rebar linestyle can be assigned to elements on 

these levels to mimic the historical depiction of reinforcing.  BRDG_Rebar-1 through 

BRDG_Rebar-4 levels have been provided for additional detailing opportunities when 

double line depiction is required or alternate weights are needed to adequately detail 

the reinforcing. 

 

Fig. B.5-7 – Generic Reinforcing Levels 
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B.6 Cell Libraries 

Cell libraries are ordinary MicroStation design files that have a .cel extension, with 

multiple models, one for each cell. 

Staff Bridge has created cell libraries containing useful details for use in detailing CDOT 

bridge projects. Those library files are named Bridge.cel, Bridge Repair.cel, Bridge 

Reinforcing.cel and Bridge Piping.cel. There are also local developmental cell libraries 

for testing new cells prior to incorporating them into the configuration. 

To view all cells contained in a library, open the Cell Library dialog box by selecting 

Element > Cells and then File > Attach File.   

MicroStation provides other methods of accessing the cell libraries, including 

customized toolboxes, cell selector tools, etc. 

The detailer may choose to create his or her own cells and cell libraries. It is important 

to place the cell origin in a useful location and to place each element of the cell in the 

appropriate level.  The cell can then be saved in one of the existing developmental 

libraries (located on \\ \\public\Bridge Common\002 Bridge Program Support\006 

Subject Matter Expert SME\SME Software\Bentley\MicroStation Basic and SS4\CELLS) 

so everyone has access to it.  The Staff Bridge development library is DesignCells.cel  

(\\public\Bridge Common\002 Bridge Program Support\006 Subject Matter Expert 

SME\SME Software\Bentley\MicroStation Basic and SS4\CELLS\DesignCells.cel).  New 

cells are kept here until they are incorporated into the configuration and then deleted. 

The steps to attach this cell library (or any cell library) are: 

From the place active cell window you can pick on the three dots to browse the cell 

selection possibilities 

 

From this Cell library window you can select “File” in the upper left 

 

file://///public/Bridge%20Common/002%20Bridge%20Program%20Support/006%20Subject%20Matter%20Expert%20SME/SME%20Software/Bentley/MicroStation%20Basic%20and%20SS4/CELLS/DesignCells.cel
file://///public/Bridge%20Common/002%20Bridge%20Program%20Support/006%20Subject%20Matter%20Expert%20SME/SME%20Software/Bentley/MicroStation%20Basic%20and%20SS4/CELLS/DesignCells.cel
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This will bring up a list of attached cell libraries from the configuration which can be 

selected or you can select “Attach File” to attach a cell library manually. 

 

You can then path to the location of the DesignCells library or any other cell library 

available. 
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The bridge cell libraries can be attached through the ribbon as well. 

 

Cells can be selected using the Cell Selectors in the ribbon as an alternative as 

mentioned above. 
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For more information on how to create a cell library and cells, see the MicroStation 

Help.   
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B.7 Annotation / Text Styles 

The following table describes the text styles used on bridge drawings: 

Text Style 

 

Use 

 

07_ENG-100 General notes and detailing text 

07_ENG-80 Reduced width font for use in conserving space on plan sheet 

10_ENG-100 Title Text 

05_ENG-100 Rebar dimensioning normal 

05_ENG-80 Rebar dimensioning – conserving space 

 
Unfortunately, outdated text styles that should no longer be used can still be found in 

archived drawings and they should be replaced with the new styles from the table. For 

that, the methodology is: Element > Text Styles > Select style to change and right click 

> Remap Elements…> Pick the new style in the Destination box, then click OK.  Once 

replaced, the old text styles can and should be purged (deleted).  A note of caution: 

remapping might cause unwanted changes in the text appearance that need to be 

addressed. 

 

Fig. B.7-1 - Replacing old text styles 

Text notes are controlled by the dimension styles and they should be put in the level 

Text.   
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B.8 Dimension Styles 

The MicroStation Dimension Style for most details should be CDOT 3.  This style is a 

normal architectural style (feet and inches). 

Dimension style CDOT 5 should be used for the footing & piling layout plan.  It shows 

dimensions in decimal feet, which is more appropriate for the surveying required to 

locate the piles and footings.  

The dimension style dialog box can be accessed from Element – Dimension Styles. 

 

Fig. B.8-1 Dimension Style Dialog Box - Units 

The orientation of the dimension text can be modified from Dimension Styles settings – 

Text – Orientation – Horizontal/Aligned.   

Changes can be made to the dimension style as the need arises during detailing, i.e., 

when using angular dimensioning, angle format can be changed from units “Angle” to 

units “Length” to show arc size length in feet and inches instead of the angle value in 

degrees/ minutes/ seconds. 
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Fig. B.8-2 Dimension Style Dialog Box – Changing Angle Format 

Text notes are drawn by default with just an arrow.  You can change the terminator by 

selecting a cell or symbol (Element > Dimension Styles > Geometry > Terminators > 

Symbols > Note: select Cell or Symbol).  The symbols are not set up currently.  The 

default cell is set up to be the integral arrow cell that looks 

like this (see Fig. B.8-3). 
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Fig. B.8-3 Selecting Integral Arrow style for Note leaders 
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B.9 Printing 

Before printing the drawing it is important to apply the print style, whether it is a hard 

print or a pdf print. In order to do that, from the Print menu > Settings > Apply Print Style 

select the printer/plotter desired.  It can also be selected using the printer selections.  By 

default, the CDOT Default Printer - ROW is the one that is used for printing to a physical 

printer. In the 10.10 & 12 configuration, you usually have to open a file twice in 

succession in order for the linestyles to appear correctly when printing. 

 

 

 

 

 

 

Fig. B.9-1 Print Style Selection 
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Currently, there are several CDOT printer drivers available.  The printer drivers control 

plotting devices, plot sizes, pen tables etc. The standard plot size for all bridge drawings 

is 11x17.  The default pen tables assigned to the different pdf options print all bridge 

levels in black/white.  If a color print is desired, the detailer will go to Print > PenTable > 

Attach and select one of the color pen tables available. (see Fig. B.9-2)  The available 

pen tables are dependent on the version used. 

 

 

Fig. B.9-2 Pen Table Selection 
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Printing 3D Isometrics 

When isometrics are printing in color and the cache is lost or red, a configuration 

variable may need to be changed (at least temporarily).  The variable is  

MS_REF_NO_CVE_LOAD.  By default it is set to 1.  Setting it to 0 and closing and 

reopening file should fix the issue.  This variable may affect how other 3D operations 

work so should be reset to 0 after printing is accomplished.  This variable may be found 

in the settings and configuration variables.  This may change in the 2024 configuration. 
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B.10 Minimum Electronic Standards for ORD/OBM Drawings 

See Chapter 3.10 and 3.11 for best practices. 

B.11 ORD Things that are Good to Know 

1) A practice that seems to work well for copying from one file to another: Reference 
in the item to be copied, select and copy the element of interest.  You can detach 
the reference when you’re finished with it.  WARNING!!!  Do not copy intelligent 
elements from ORD files to OBD/OBM files or vice versa.  This may cause 
corruption of the files. 

2) The drawing border should be placed at 0,0,0.  A trick for finding this location is to 
take the following steps: 

o select the “Place SmartLine” tool,  

o data on the beginning point,  

o type p, 

o type “0,0,0” (zero, zero, zero, including commas), click enter,  

o data end point. 

You will have created an arrow (of sorts) that points to the 0,0,0 coordinate.  
Consistently placing line work at this location will help preclude the loss of 
drawings in the vast expanses of MicroStation. 

3) When adding dimensions it is helpful to open the Dimension Styles window 
(Element\Dimension Styles) so that you can make changes on the fly in placement 
and symbols. 

4) Draw line work in “default” model and change the model name to “linework”.  The 
default model is the Master model, that can’t be deleted by mistake.  If the Bridge 
seed file is used, the linework model is already set up as the default. 

5) If menus/windows disappear off your screen or are halfway off, making them 
unusable, change your screen resolution to a different setting, reposition the 
menu/window and then go back to default screen resolution. To get to the screen 
resolution, right-click the mouse in your desktop screen. 

6) When the Sheet Border is created using 1” = 1”, and the Annotation Scale is locked 

ON and is 1”=1”, life is good and text is always the right size for the drawing. 

 

ORD COMPATIBILITY BETWEEN VERSIONS – LINE STYLE UPDATE 
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B.12 3D Stuff 

1) To create a solid from shapes 
a) Stitch shapes into a mesh in modeling/mesh tab   

 
b) Convert to smart solid in solid utilities 

 

 
 
 
2) If solids don’t merge with the merge command, you may need to convert them to 

smart solids.  Common extrusion commands sometimes create parametric solids 
which are more difficult to deal with. 

3) For printing issues of 3D isometrics see Section B.9 

 

B.13 Handy Tools 

1) A tool exists to set superscript and subscript to 75% of the text height attaining 
approximately a text height similar to 05_ENG-100 for the superscripts and 
subscripts when used.  The default is 30% which is generally too small for 
legibility. 

 
 
2) Several detailing tools exist which can be accessed from the Bridge Tools drop 

down. These include: 
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a) Place Steel – This tool will place a cell or linework for most steel shapes.  

Several libraries are included in the library.  Many old WF sections are included 
as well that have been used on CDOT bridges. 

 

 

 
 

b) Pipe End/Breaks – This tool allows breaking linework to show different types of 
end breaks and mid-breaks for for several shapes. 
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c) Caisson Break Line – Adds curved end breaks for round sections 

 
 
3) Other tools (TBD) 


